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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Ue the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Product Name Compaq Presario CQ58 √  

 HP 2000 Notebook PC  √

Processors ● Intel® Dual Core® i5-3230M 2.60-GHz
processor (SC turbo up to 3.20-GHz; 1600-
MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i5-3210M 2.50-GHz processor
(SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

● Intel Dual Core i3-3130M 2.60-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-3120M 2.50-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-2348M 2.30-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-3110M 2.30-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-2370M 2.40-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-2350M 2.30-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-2330M 2.20-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i3-2328M 2.20-GHz processor
(1333-MHz FSB, 3.0-MB L3 cache, 35 W)

√ √
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Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Processors (continued) ● Intel Pentium 2030M 2.50-GHz processor
(1600-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Pentium 2020M 2.40-GHz processor
(1600-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Pentium B980 TJ85 2.40-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Pentium B970 TJ85 2.30-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Pentium B960 TJ85 2.20-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Pentium B950 TJ85 2.10-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Celeron DC 1000M 1.80-GHz processor
(1600-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Celeron DC B830 1.80-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

● Intel Celeron DC B820 1.70-GHz processor
(1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

√ √

Chipset ● Intel HM75 Express chipset (only on computer
models equipped an Intel Core i5 or
i3 processor)

● Intel HM70 Express chipset (only on computer
models equipped an Intel Pentium or
Intel Celeron processor)

√ √
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Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Graphics Internal graphics:

● Universal memory architecture (UMA) with
shared video memory

● Intel HD Graphics 4000 (GT2) on computer
models equipped with an Intel Core i5-3210M
or Intel Core i3-3110M processor

● Intel HD Graphics 3000 (GT2) on computer
models equipped with an Intel Core i3-2370M,
Intel Core i3-2350M, or i3-2330M processor

● Intel HD Graphics (GT1) on computer models
equipped with an Intel Pentium or
Intel Celeron processor

Supports HD decode, HDMI, and DX11 (DX11 not
supported on computer models equipped with an
Intel Core i3-2370M, i3-2350M, or
i3-2330M processor)

√ √

Panel 15.6-in, light-emitting diode (LED), SVA, HD,
BrightView (1366×768) display;
typical brightness: 200 nits

All display assemblies include one or two wireless
local area network (WLAN) antenna cables

Supports low voltage differential signalling (LVDS)

√ √

Memory Two customer-accessible/upgradable memory
module slots

DDR3/1333-MHz dual-channel support
(DDR3/1600-MHz downgrade to DDR3-1333)

Supports 8192-MB of system RAM in the
following configurations:

● 8192-MB (4096-MB×2; not supported on
computer models equipped with a 32-bit
operating system)

● 6144-MB (4096-MB+2048×1; not supported
on computer models equipped with a 32-bit
operating system)

● 4086-MB (4096-MB×1 or 2048×2; not
supported on computer models equipped with
Windows 7, 32-bit operating system)

● 2048-MB (2048×1; not supported on computer
models equipped with Windows 7, 32-bit
operating system)

√ √
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Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Hard drive Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.
37-in) and 7.0-mm (.28-in) thicknesses (all hard
drives use the same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

● 750-GB, 5400-rpm, 9.5-mm (not supported on
computer models equipped with Windows 7
Starter, 32-bit operating system)

● 640-GB, 5400-rpm, 9.5-mm (not supported on
computer models equipped with Windows 7
Starter, 32-bit operating system)

● 500-GB, 5400-rpm, 9.5-mm

● 320-GB, 5400-rpm, 9.5-mm

√ √

Optical drive Fixed

Serial ATA

12.7-mm tray load

Supports DVD±RW Double-Layer with
SuperMulti Drive

Supports zero power optical drive

√ √

Audio and video Two Altec-Lansing speakers √ √

 HD audio √ √

 Supports Microsoft premium requirements √ √

 VGA webcamera (fixed, no tilt with activity LED;
640×480 by 24 frames per second)

√ √

 One digital microphone √ √

Ethernet Integrated 10/100 network interface card (NIC) √ √

Wireless Integrated wireless local area network (WLAN)
options by way of wireless module

√ √

 One or two WLAN antennas built into display
assembly, varying by computer model

√ √
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Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Wireless (continued) Support for the following WLAN formats:

● Atheros AR9565 802.11b/g/n 1×1 WiFi +
BT4.0 Combo Adapter

● Atheros HB125 802.11b/g/n 1×1
WLAN module

● Atheros 9485GN 802.11b/g/n 1×1 WiFi and
3012 Bluetooth 4.0 Combo Adapter

● Broadcom 4313GN 802.11b/g/n 1×1 WiFi
and 20702 Bluetooth 4.0 Combo Adapter

● Ralink RT5390F 802.11b/g/n 1×1
WLAN module

● Ralink RT5390R 802.11bg/n 1×1
WiFi Adapter

● Ralink RT3290LE 802.11b/g/n 1×1 WiFi and
Bluetooth 4.0 Combo Adapter

√ √

External media cards HP Multi-Format Digital Media reader with push-push
technology, supporting:

● Secure Digital (SD) Memory Card

● Secure Digital Extended Capacity (SDxC)
Memory Card

● Secure Digital High Capacity (SDHC)
Memory Card

● MultiMediaCard (MMC)

√ √

Ports ● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● HDMI v1.4 supporting: up to 1920×1200
@ 60Hz

● HP Smart AC adapter

● RJ-45 (Ethernet Gigabit support with
LED indicators)

● USB 2.0 ports on computer: 3 (2 on one side, 1
on other; USB port allocation: 3 for the
computer, 1 for camera 1 for MiniCard)

● VGA (Dsub 15 pin) supporting: 2048×1536
external resolution @ 75 Hz, hot plug and
unplug and autodetection for correct output to
wide-aspect vs. standard aspect video

√ √

Keyboard/pointing
devices

Full-size (15.6-in.), textured, pocket keyboard, no
numeric keypad

√ √
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Category Description Compaq
Presario

CQ58

HP 2000
Notebook PC

Keyboard/pointing
devices (continued)

Gesture support: MultiTouch gestures enabled, two-
finger scrolling, and pinch-zoom as default

√ √

 Taps enabled by default √ √

Power requirements 65W RC, V, EM, 3-wire HP Smart AC adapter with
localized cable plug support (3-wire plug with
ground pin, supports 3-pin DC connector)

√ √

 Supports the following batteries:

● 6-cell, 55-Wh, 2.55-Ah, Li-ion battery

● 6-cell, 47-Wh, 2.20-Ah, Li-ion battery

√ √

Security Supports security cable lock √ √

Operating system Preinstalled:

● Windows® 8 Professional

● Windows 8 Standard

● SUSE Linux (only on computer models equipped
with the Intel HM70 Express Chipset)

● FreeDOS 2.0

√ √

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Memory module

● Optical drive

● WLAN module

√ √
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2 External component identification

Finding your hardware and software information
▲ Select Start > Computer.

A list displays all the devices installed in your computer, including hard drive, optical drives, solid-state
drives (SSD), or a secondary hard drive.

To find out what software is included on your computer, select Start > All Programs.

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs.

(2) Internal microphone Records sound.

Finding your hardware and software information 7



Item Component Description

(3) Webcam Records video, captures still photographs, and allows
video conferences and online chat by means of
streaming video.

To use the webcam, select Start > All Programs >
Communication and Chat > CyberLink YouCam.

(4) Webcam light On: The webcam is in use.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Button

Component Description

Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press
the button briefly to exit Sleep.

● When the computer is in Hibernation, press
the button briefly to exit Hibernation.

CAUTION: Pressing and holding down the power
button will result in the loss of unsaved information.

If the computer has stopped responding and Microsoft
Windows shutdown procedures are ineffective, press and
hold the power button down for at least 5 seconds to turn
off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options.

Button 9



Keys

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Used in conjunction with hotkeys.

(3) Windows logo key Displays the Windows Start menu.

(4) Action keys Execute frequently used system functions.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.
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Lights

Item Component Description

(1) Caps lock light On: Caps lock is on, which switches the keys to all
capital letters.

(2) Power light ● White: The computer is on.

● Blinking white: The computer is in the Sleep state,
which is an energy-saving mode. The computer
shuts off power to the display and other
unneeded components.

● Off: The computer is off or in Hibernation.
Hibernation is an energy-saving mode that uses the
least amount of power.

(3) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

Lights 11



TouchPad

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on or off.

(2) TouchPad light ● On: The TouchPad is off.

● Off: The TouchPad is on.

(3) TouchPad zone Moves the on-screen pointer and selects or activates items
on the screen.

(4) Left TouchPad button Functions like the left button on an external mouse.

(5) Right TouchPad button Functions like the right button on an external mouse.

Front

Component Description

Speakers Produce sound.
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Left side

Item Component Description

(1) External monitor port Connects an external VGA monitor or projector.

(2) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(3) RJ-45 (network) jack Connects a network cable.

(4) HDMI port Connects an optional video or audio device, such as a
high-definition television, any compatible digital or
audio device.

(5) USB port Connects an optional USB device.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7) Audio-out (headphone) jack Connects optional powered stereo speakers,
headphones, earbuds, a headset, or a television
audio cable.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and Environmental
Notices.

NOTE: When a device is connected to the jack,
the computer speakers are disabled.
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Item Component Description

(8) Digital Media slot Supports the following digital card formats:

● Secure Digital (SD) Memory Card

● Secure Digital Extended Capacity (SDxC)
Memory Card

● Secure Digital High Capacity (SDHC) Memory Card

● MultiMediaCard (MMC)

(9) Hard drive light Blinking white: The hard drive is being accessed.

(10) Power light ● White: The computer is on.

● Blinking white: The computer is in the Sleep state,
which is an energy-saving mode. The computer shuts
off power to the display and other
unneeded components.

14 Chapter 2   External component identification



Right side

Item Component Description

(1) Optical drive Reads and writes (select models only) to an optical disk.

(2) Optical drive light ● Green: The optical drive is being accessed.

● Off: The optical drive is idle.

(3) Optical drive eject button Releases the disc tray.

(4) USB port Connects an optional USB device.

CAUTION: While there are multiple USB ports on the
same side, only one USB port will able to support a high
power device at a time.

(5) AC adapter light ● White: The AC adapter is connected and the battery
is charged.

● Amber: The AC adapter is connected and the
battery is charging.

● Off: The computer is using DC power.

(6) Power connector Connects an AC adapter.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Bottom

Item Component Description

(1) Battery bay Holds the battery.

(2) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(3) Battery release latch Releases the battery from the battery bay.

(4) Memory module/wireless module
compartment cover

The memory module/wireless module compartment cover
provides access to the memory module compartment,
wireless module compartment, keyboard retention screw,
and optical drive bay.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact customer support
through Help and Support.

(5) Hard drive compartment cover The hard drive compartment cover provides access to the
hard drive bay and the RTC battery.
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3 Illustrated parts catalog
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Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components

Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 24.

Computer major components 19



Item Component Spare part number

(2) Keyboard (includes keyboard cable):

 For use in Belgium 698694-A41

 For use in Bulgaria 698694-261

 For use in the Czech Republic and Slovakia 698694-221

 For use in Denmark, Finland, and Norway 698694-DH1

 For use in France 698694-051

 For use in Germany 698694-041

 For use in Greece 698694-DJ1

 For use in Hungary 698694-211

 For use in Israel 698694-BB1

 For use in Italy 698694-061

 For use in the Netherlands 698694-B31

 For use in Portugal 698694-131

 For use in Romania 698694-271

 For use in Russia 698694-251

 For use in Saudi Arabia 698694-171

 For use in Slovenia 698694-BA1

 For use in South Korea 698694-AD1

 For use in Spain 698694-071

 For use in Switzerland 698694-BG1

 For use in Taiwan 698694-AB1

 For use in Thailand 698694-281

 For use in Turkey 698694-141

 For use in the United Kingdom 698694-031

 For use in the United States 698694-001

(3) Top cover (includes the TouchPad board):

 In black licorice finish for use on Compaq Presario CQ58 computer models 686283-001

 In black licorice finish for use on HP 2000 Notebook PC computer models 686282-001

 In winter blue finish for use on HP 2000 Notebook PC computer models 686284-001

(4) Power button board (includes cable) 686270-001

(5) TouchPad button board (includes bracket, TouchPad button board cable, and
TouchPad cable)

686271-001

(6) Speakers (include speaker cables) 686279-001
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Item Component Spare part number

(7) Optical drive connector cable (includes bracket) 686257-001

(8) USB board (includes cable) 686269-001

(9) System board (includes replacement thermal material):

 Equipped with the Intel HM75 Express chipset, an Intel Dual Core i5 or i3 processor,
and the Windows 8 Professional operating system

686280-601

 Equipped with the Intel HM75 Express chipset, an Intel Dual Core i5 or i3 processor,
and the Windows 8 Standard operating system

686280-501

 Equipped with the Intel HM70 Express chipset, an Intel Pentium or Celeron processor,
and the Windows 8 Professional operating system

688018-601

 Equipped with the Intel HM70 Express chipset, an Intel Pentium or Celeron processor,
and the Windows 8 Standard operating system

688018-501

(10) Processor (includes replacement thermal material):

 Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

711903-001

 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

680645-001

 Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

713163-001

 Intel Dual Core i3-3120M 2.50-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

700627-001

 Intel Dual Core i3-2348M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

713165-001

 Intel Dual Core i3-3110M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

682417-001

 Intel Dual Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

677152-001

 Intel Dual Core i3-2350M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

653340-001

 Intel Dual Core i3-2330M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

653339-001

 Intel Dual Core i3-2328M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache,
35 W)

693542-001

 Intel Pentium 2030M 2.50-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

713164-001

 Intel Pentium 2020M 2.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

700628-001

 Intel Pentium B980 TJ85 2.40-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

692428-001

 Intel Pentium B970 TJ85 2.30-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

676785-001
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Item Component Spare part number

 Intel Pentium B960 TJ85 2.20-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

664662-001

 Intel Pentium B950 TJ85 2.10-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

653338-001

 Intel Celeron DC 1000M 1.80-GHz processor (1600-MHz FSB, 2.0-MB L3 cache,
dual core, 35 W)

713162-001

 Intel Celeron DC B830 1.80-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

699547-001

 Intel Celeron DC B820 1.70-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual
core, 35 W)

690537-001

(11) Fan/heat sink assembly (includes replacement thermal material) 686259-001

(12) Power connector cable (includes bracket) 686258-001

(13) Base enclosure (includes battery cover lock latch, battery cover release latch, power
connector barrel, and RJ45 cover)

708523-001

 Rubber Feet Kit (not illustrated, includes front and rear rubber feet) 686276-001

(14) Battery:

 6-cell, 55-Wh, 2.55-Ah, Li-ion battery 593554-001

 6-cell, 47-Wh, 2.20-Ah, Li-ion battery 593553-001

(15) DVD±RW Double-Layer with SuperMulti Drive (includes optical drive bezel
and optical drive bracket)

686268-001

(16) RTC battery 686274-001

(17) Hard drive (does not include hard drive bracket, hard drive connector cable, or screws):

 750-GB, 5400-rpm, 9.5-mm 634250-001

 640-GB, 5400-rpm, 9.5-mm 669300-001

 500-GB, 5400-rpm, 9.5-mm 669299-001

 320-GB, 5400-rpm, 9.5-mm 622643-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, hard drive
connector cable, and screws)

686261-001

(18) Memory module (PC3, 12800, 1600-MHz):

 4-GB memory module 652972-001

 2-GB memory module 641369-001

(19) WLAN module:

 Atheros AR9565 802.11b/g/n 1×1 WiFi + BT4.0 Combo Adapter 690019-001

 Atheros HB125 802.11b/g/n 1×1 WLAN module 675794-001

 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001
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Item Component Spare part number

 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0
Combo Adapter

657325-001

 Ralink RT5390F 802.11b/g/n 1×1 WLAN module 670691-001

 Ralink RT5390R 802.11bg/n 1×1 WiFi Adapter 691415-001

 Ralink RT3290LE 802.11b/g/n 1×1 WiFi and Bluetooth 4.0 Combo Adapter 690020-001

 Cover Kit, includes: 686272-001

(20) Hard drive compartment cover (includes one captive screw, secured by a C-clip)

(21) Memory module/wireless module compartment cover (includes one captive screw, secured by a C-clip)
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel:

 For use on Compaq Presario CQ58 computer models 686255-001

 For use on HP 2000 Notebook PC computer models 686254-001

(2) Webcam/microphone module (includes double-sided adhesive):

 HD webcam/microphone module 703461-001

 Non-HD webcam/microphone module 686285-001
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Item Component Spare part number

(3) 15.6-in, LED, SVA, HD, BrightView display panel 686273-001

(4) Display Hinge Cover Kit (includes left and right display hinge covers) 686260-001

(5) Display hinges (includes vertical support brackets) 686262-001

(6) Display panel cable (includes webcam/microphone module cable) 686256-001

(7) Antenna Kit (includes wireless antenna left and right (main and auxiliary) cables
and transceivers)

686249-001

(8) Display enclosure:

 In black licorice finish for use on Compaq Presario CQ58 computer models 686251-001

 In black licorice finish for use on HP 2000 Notebook PC computer models 686250-001

 In winter blue finish for use on HP 2000 Notebook PC computer models 686252-001

 Display Rubber Kit (not illustrated, includes display assembly rubber bumpers and
screw covers)

686275-001
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Mass storage devices

Item Component Spare part number

(1) Hard drive (does not include hard drive bracket, hard drive connector cable, or screws):

 750-GB, 5400-rpm, 9.5-mm 634250-001

 640-GB, 5400-rpm, 9.5-mm 669300-001

 500-GB, 5400-rpm, 9.5-mm 669299-001

 320-GB, 5400-rpm, 9.5-mm 622643-001

 Hard Drive Hardware Kit, includes: 686261-001

(2a) Hard drive bracket

(2b) Hard drive connector cable

 Hard drive bracket screws (not illustrated)

(3) DVD±RW Double-Layer with SuperMulti Drive (includes optical drive bezel
and optical drive bracket)

686268-001

26 Chapter 3   Illustrated parts catalog



Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001

65-W HP Smart AC adapter (RC, V, EM, 3-wire) 693710-001

Power cord (3-pin, black, 1.83-m):

For use in Australia 490371-011

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom and Singapore 490371-031

Screw Kit 686278-001
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Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Italy (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

593553-001 6-cell, 47-Wh, 2.20-Ah, Li-ion battery

593554-001 6-cell, 55-Wh, 2.55-Ah, Li-ion battery

622643-001 320-GB, 5400-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
cable, or screws)

NOTE: The hard drive bracket, hard drive connector cable, and screws are included in the Hard
Drive Hardware Kit, spare part number 686261-001.

634250-001 750-GB, 5400-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
cable, or screws)

NOTE: The hard drive bracket, hard drive connector cable, and screws are included in the Hard
Drive Hardware Kit, spare part number 686261-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

653338-001 Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653339-001 Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653340-001 Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

655795-001 Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

657325-001 Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter
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Spare part number Description

664662-001 Intel Pentium B960 TJ85 2.20-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

669299-001 500-GB, 5400-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
cable, or screws)

NOTE: The hard drive bracket, hard drive connector cable, and screws are included in the Hard
Drive Hardware Kit, spare part number 686261-001.

669300-001 640-GB, 5400-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
cable, or screws)

NOTE: The hard drive bracket, hard drive connector cable, and screws are included in the Hard
Drive Hardware Kit, spare part number 686261-001.

670691-001 Ralink RT5390F 802.11b/g/n 1×1 WLAN module

675794-001 Atheros HB125 802.11b/g/n 1×1 WLAN module

676785-001 Intel Pentium B970 TJ85 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

677152-001 Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

680645-001 Intel Core i5-3210M 2.50-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

682417-001 Intel Core i3-3110M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

686249-001 Antenna Kit (includes wireless antenna left and right (main and auxiliary) cables and transceivers)

686250-001 Display enclosure in black licorice finish for use on HP 2000 Notebook PC computer models

686251-001 Display enclosure in black licorice finish for use on Compaq Presario CQ58 computer models

686252-001 Display enclosure in winter blue finish for use on HP 2000 Notebook PC computer models

686254-001 Display bezel for use on HP 2000 Notebook PC computer models

686255-001 Display bezel for use on Compaq Presario CQ58 computer models

686256-001 Display panel cable (includes webcam/microphone module cable)

686257-001 Optical drive connector cable (includes bracket)

686258-001 Power connector cable

686259-001 Fan/heat sink assembly (includes replacement thermal material)

686261-001 Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector cable, and screws)

686262-001 Display hinges (includes vertical support brackets)

686268-001 DVD±RW Double-Layer with SuperMulti Drive (includes optical drive bezel and optical
drive bracket)

686269-001 USB board (includes cable)

686270-001 Power button board (includes cable)

686271-001 TouchPad button board (includes bracket, TouchPad button board cable, and TouchPad cable)

Sequential part number listing 29



Spare part number Description

686272-001 Cover Kit (includes hard drive compartment cover and memory module/wireless module
compartment cover)

686273-001 15.6-in, LED, SVA, HD, BrightView display panel

686274-001 RTC battery

686276-001 Rubber Feet Kit (includes front and rear rubber feet)

686278-001 Screw Kit

686279-001 Speakers (include speaker cables

686280-501 System board for use on computer models equipped with the HM75 Express chipset, an Intel Dual
Core i5 or i3 processor, and the Windows 8 Standard operating system (includes replacement
thermal material)

686280-601 System board for use on computer models equipped with the HM75 Express chipset, an Intel Dual
Core i5 or i3 processor, and the Windows 8 Professional operating system (includes replacement
thermal material)

686282-001 Top cover in black licorice finish for use on HP 2000 Notebook PC computer models
(includes the TouchPad board)

686283-001 Top cover in black licorice finish for use on Compaq Presario CQ58 computer models
(includes the TouchPad board)

686284-001 Top cover in winter blue finish for use on HP 2000 Notebook PC computer models
(includes the TouchPad board)

686285-001 Non-HD webcam/microphone module (includes double-sided adhesive)

688018-501 System board for use on computer models equipped with the HM70 Express chipset, an Intel Dual
Core i5 or i3 processor, and the Windows 8 Standard operating system (includes replacement
thermal material)

688018-601 System board for use on computer models equipped with the HM70 Express chipset, an Intel Dual
Core i5 or i3 processor, and the Windows 8 Professional operating system (includes replacement
thermal material)

690019-001 Atheros AR9565 802.11b/g/n 1×1 WiFi + Bluetooth 4.0 Combo Adapter

690020-001 Ralink RT3290LE 802.11b/g/n 1×1 WiFi and Bluetooth 4.0 Combo Adapter

690537-001 Intel Celeron DC B820 1.70-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

691415-001 Ralink RT5390R 802.11bg/n 1×1 WiFi Adapter

692428-001 Intel Pentium B980 TJ85 2.40-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

693542-001 Intel Dual Core i3-2328M 2.20-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, dual core, 35
W; includes replacement thermal material)

693710-001 65-W HP Smart AC adapter (RC, V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

698694-001 Keyboard for use in the United States (includes keyboard cable)

698694-031 Keyboard for use in the United Kingdom and Singapore (includes keyboard cable)
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Spare part number Description

698694-041 Keyboard for use in Germany (includes keyboard cable)

698694-051 Keyboard for use in France (includes keyboard cable)

698694-061 Keyboard for use in Italy (includes keyboard cable)

698694-071 Keyboard for use in Spain (includes keyboard cable)

698694-131 Keyboard for use in Portugal (includes keyboard cable)

698694-141 Keyboard for use in Turkey (includes keyboard cable)

698694-151 Keyboard for use in Greece (includes keyboard cable)

698694-171 Keyboard for use in Saudi Arabia (includes keyboard cable)

698694-211 Keyboard for use in Hungary (includes keyboard cable)

698694-251 Keyboard for use in Russia (includes keyboard cable)

698694-261 Keyboard for use in Bulgaria (includes keyboard cable)

698694-271 Keyboard for use in Romania (includes keyboard cable)

698694-281 Keyboard for use in Thailand (includes keyboard cable)

698694-A41 Keyboard for use in Belgium (includes keyboard cable)

698694-AB1 Keyboard for use in Taiwan (includes keyboard cable)

698694-AD1 Keyboard for use in South Korea (includes keyboard cable)

698694-B31 Keyboard for use in the Netherlands (includes keyboard cable)

698694-BA1 Keyboard for use in Slovenia (includes keyboard cable)

698694-BB1 Keyboard for use in Israel (includes keyboard cable)

698694-BG1 Keyboard for use in Switzerland (includes keyboard cable)

698694-DH1 Keyboard for use in Denmark, Finland, and Norway (includes keyboard cable)

698694-FL1 Keyboard for use in Greece (includes keyboard cable)

699547-001 Intel Celeron DC B830 1.80-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

700627-001 Intel Dual Core i3-3120M 2.50-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

700628-001 Intel Pentium 2020M 2.40-GHz processor (1600-MHz FSB, 2.0-L3 cache, dual core, 35 W;
includes replacement thermal material)

703461-001 HD webcam/microphone module (includes double-sided adhesive)

708523-001 Base enclosure (includes battery cover lock latch, battery cover release latch, power connector
barrel, and RJ45 cover)

711903-001 Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

713162-001 Intel Celeron DC 1000M 1.80-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual core, 35
W); includes replacement thermal material)
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Spare part number Description

713163-001 Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

713164-001 Intel Pentium 2030M 2.50-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

713165-001 Intel Dual Core i3-2348M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Preliminary replacement requirements 33



Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 72 screws that must be removed, replaced, and/or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 40 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about
the product’s hardware components. The part number
helps a service technician determine what components
and parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to
the base enclosure, as indicated in the illustration below. These rubber feet are available in the Rubber
Feet Kit, spare part number 686276-001.
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Battery

Description Spare part number

6-cell, 55-Wh, 2.55-Ah, Li-ion battery 593554-001

6-cell, 47-Wh, 2.20-Ah, Li-ion battery 593553-001

IMPORTANT: The customer should not attempt to replace the computer battery, which is installed
and sealed at the factory. A broken battery seal voids the computer and battery warranties. The
computer has an internal rechargeable battery that can be replaced only by an authorized service
provider.

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the front edge of the battery (2) up and back.

4. Remove the battery (3) from the computer.

To insert the battery:

1. Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery bay.

2. Pivot the front edge of the battery down into the battery bay until it is seated. (The battery release
latch will automatically lock into place.)

40 Chapter 4   Removal and replacement procedures



Memory module

Description Spare part number

4-GB memory module (PC3, 12800, 1600-MHz) 652972-001

2-GB memory module (PC3, 12800, 1600-MHz) 641369-001

Before removing the memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

Remove the memory module:

1. Loosen the captive screw (1) that secures the memory module/wireless module compartment cover
to the computer.

2. Lift the rear edge of the memory module/wireless module compartment cover (2) up and forward
until it rests at an angle.

3. Remove the memory module/wireless module compartment cover (3) by sliding it away from the
computer at an angle. The memory module/wireless module compartment cover is available in the
Cover Kit, spare part number 686272-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)
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5. Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.

WLAN module

Description Spare part number

Atheros AR9565 802.11b/g/n 1×1 WiFi + BT4.0 Combo Adapter 690019-001

Atheros HB125 802.11b/g/n 1×1 WLAN module 675794-001

Atheros 9485GN 802.11b/g/n 1×1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Ralink RT5390F 802.11b/g/n 1×1 WLAN module 670691-001

Ralink RT5390R 802.11bg/n 1×1 WiFi Adapter 691415-001

Ralink RT3290LE 802.11b/g/n 1×1 WiFi and Bluetooth 4.0 Combo Adapter 690020-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
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3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the memory module/wireless module compartment cover (see Memory module
on page 41).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The #1 WLAN antenna cable is connected to the WLAN module #1 terminal. The #2
WLAN antenna cable is connected to the WLAN module #2 terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up.)
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3. Remove the WLAN module by pulling the module away from the slot at an angle (3).

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module,
the protective sleeves must be installed on the antenna connectors, as shown in the
following illustration.

Reverse this procedure to install the WLAN module.
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Keyboard

NOTE: The keyboard spare part kit includes the keyboard cable.

For use in country/region Spare part number For use in country/region Spare part number

For use in Belgium 698694-A41 For use in Romania 698694-271

For use in Bulgaria 698694-261 For use in Russia 698694-251

For use in the Czech Republic
and Slovakia

698694-FL1 For use in Saudi Arabia 698694-171

For use in Denmark, Finland,
and Norway

698694-DH1 For use in Slovenia 698694-BA1

For use in France 698694-051 For use in South Korea 698694-AD1

For use in Germany 698694-041 For use in Spain 698694-071

For use in Greece 698694-151 For use in Switzerland 698694-BG1

For use in Hungary 698694-211 For use in Taiwan 698694-AB1

For use in Israel 698694-BB1 For use in Thailand 698694-281

For use in Italy 698694-061 For use in Turkey 698694-141

For use in the Netherlands 698694-B31 For use in the United Kingdom 698694-031

For use in Portugal 698694-131 For use in the United States 698694-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the memory module/wireless module compartment cover (see Memory module
on page 41).
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Remove the keyboard:

1. Remove the Phillips PM2.5×4.0 screw that secures the keyboard to the computer.

2. Rest and secure the computer on its left side.

3. Partially open the computer.
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4. Insert a screw driver or similar thin tool into the keyboard release hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest.
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard (3).

Reverse this procedure to install the keyboard.
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Optical drive

Description Spare part number

DVD±RW Double-Layer with SuperMulti Drive (includes optical drive bezel and optical
drive bracket)

686268-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the memory module/wireless module compartment cover (see Memory module
on page 41).

Remove the optical drive:

1. Remove the Phillips PM2.5×4.0 screw (1) that secures the optical drive to the computer.

2. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.

3. Remove the optical drive (3) from the computer.

Component replacement procedures 49



4. If it is necessary to replace the optical drive bezel, use a thin tool or an unbent paper clip (1) to
release the optical drive tray.

5. Use a flat-blade screw driver or similar tool to press on the optical drive bezel tab (2) to release
the optical drive bezel.

6. Release the left side of the optical drive bezel (3).

7. Remove the optical drive bezel (4).

8. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

9. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.

10. Remove the optical drive bracket (2).

Reverse this procedure to install the optical drive.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket, hard drive connector
cable, or screws.

Description Spare part number

750-GB, 5400-rpm, 9.5-mm 634250-001

640-GB, 5400-rpm, 9.5-mm 669300-001

500-GB, 5400-rpm, 9.5-mm 669299-001

320-GB, 5400-rpm, 9.5-mm 622643-001

Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector cable, and screws) 686261-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the memory module/wireless module compartment cover (see Memory module
on page 41).

Remove the hard drive:

1. Loosen the captive screw (1) that secures the hard drive compartment cover to the computer.

2. Lift the rear edge of the hard drive compartment cover (2) up and forward until it rests at
an angle.
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3. Remove the hard drive compartment cover (3) by sliding it away from the computer at an angle.
The hard drive compartment cover is available in the Cover Kit, spare part number 686272-001.

4. Disconnect the hard drive connector cable (1) from the system board, and then release the cable
from the clip (2) built into the base enclosure.

5. Remove the four Phillips PM2.5×4.0 screws (3) that secure the hard drive to the computer.

6. Remove the hard drive (4) from the hard drive bay.
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7. If it is necessary to disassemble the hard drive, perform the following steps:

a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive.

c. Disconnect the hard drive connector cable (3) from the hard drive. The hard drive bracket,
hard drive connector cable, and screws are available in the Hard Drive Hardware Kit, spare
part number 686261-001.

Reverse this procedure to reassemble and install the hard drive.
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RTC battery

Description Spare part number

RTC battery 686274-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the memory module/wireless module compartment cover (see Memory module
on page 41).

6. Remove the hard drive compartment cover (see Hard drive on page 51).

Remove the RTC battery:

1. Use a flat-bladed, non-metallic tool (1) to release the RTC battery from the socket on the
system board.

2. Remove the RTC battery (2).
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Reverse this procedure to install the RTC battery. When installing the RTC battery, make sure the “+”
sign faces up.

Top cover

NOTE: The top cover spare part kit includes the TouchPad board.

Description Spare part number

In black licorice finish for use on Compaq Presario CQ58 computer models 686283-001

In black licorice finish for use on HP 2000 Notebook PC computer models 686282-001

In winter blue finish for use on HP 2000 Notebook PC computer models 686284-001

Before removing the top cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

NOTE: When replacing the top cover, be sure to remove the following components from the defective
top cover and install them on the replacement top cover:

● Power button board (see Power button board on page 59)

● TouchPad button board (see TouchPad button board on page 60)
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Remove the top cover:

1. Remove the six Phillips PM2.5×6.5 screws (1) and the two Phillips PM2.5×10.0 screws (2) that
secure the top cover to the computer.

2. Remove the four Phillips PM2.0×2.5 screws on the rear edge of the battery bay and in the hard
drive bay that secure the top cover to the computer.

3. Remove the four Phillips PM2.5×4.0 screws on the front edge of the battery bay and near the hard
drive connector that secure the top cover to the computer.
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4. Turn the computer right side up, with the front toward you.

5. Open the computer.

6. Release the ZIF connector to which the power button board cable is connected, and then
disconnect the power button board cable (1) from the system board.

7. Release the ZIF connector to which the TouchPad button board cable is connected, and then
disconnect the TouchPad button board cable (2) from the system board.
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8. Remove the Phillips PM2.0×2.5 screw (1) and the three Phillips PM2.5×6.5 screws (2) that secure
the top cover to the computer.

9. Lift the rear edge of the top cover (1) and swing it up and forward until the left and right sides of
the top cover detach from the base enclosure.

10. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (includes cable) 686270-001

Before removing the power button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.

2. Remove the two Phillips PM2.0×3.0 screws (1) that secure the power button board to
the top cover.
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3. Remove the power button board (2).

Reverse this procedure to install the power button board.

TouchPad button board

Description Spare part number

TouchPad button board (includes bracket, TouchPad button board cable, and TouchPad cable) 686271-001

Before removing the TouchPad button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)
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Remove the TouchPad button board:

1. Turn the top cover upside down, with the front toward you.

2. Detach the TouchPad button board cable (1) from the TouchPad. (The TouchPad button board
cable is attached to the TouchPad with double-sided tape).

3. Release the ZIF connector to which the TouchPad board cable is connected, and then disconnect
the TouchPad board cable (2) from the TouchPad board.

4. Release the two pieces of shielding tape that cover the left and right sides of the TouchPad button
board (3).

5. Remove the two Phillips PM2.5×4.0 screws (1) that secure the TouchPad button board to the top
cover. Lift the rear edge of the TouchPad button board (2) until it rests at an angle.
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6. Remove the TouchPad button board (3) by sliding it away from the top cover at an angle.

Reverse this procedure to install the TouchPad button board.
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Optical drive connector cable

Description Spare part number

Optical drive connector cable 686257-001

Before removing the optical drive connector cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

Remove the optical drive connector cable:

1. Disconnect the optical drive connector cable (1) from the system board.

2. Release the optical drive connector cable from the clips (2) and routing channel built into
the base enclosure.

3. Remove the two Phillips PM2.0×4.5 screws (3) that secure the optical drive connector to
the base enclosure.
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4. Remove the optical drive connector cable (4).

Reverse this procedure to install the optical drive connector cable.
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Speakers

Description Spare part number

Speakers (include speaker cables) 686279-001

Before removing the speakers, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

Remove the speakers:

1. Disconnect the speaker cable (1) from the system board.

2. Release the speaker cable from the clips (2) and routing channel built into the base enclosure.

3. Remove the two Phillips PM2.5×4.0 screws (3) that secure the speakers to the base enclosure.

Component replacement procedures 65



4. Remove the speakers (4).

Reverse this procedure to install the speakers.
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USB board

Description Spare part number

USB board (includes cable) 686269-001

Before removing the USB board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

Remove the USB board:

1. Release the ZIF connector to which the USB board cable is connected, and then disconnect
the USB board cable (1) from the system board.

2. Remove the Phillips PM2.5×6.0 screw (2) that secures the USB board to the base enclosure.
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3. Remove the USB board (3).

Reverse this procedure to install the USB board.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

Equipped with the Intel HM75 Express chipset, an Intel Dual Core i5 or i3 processor, and the
Windows 8 Professional operating system

686280-601

Equipped with the Intel HM75 Express chipset, an Intel Dual Core i5 or i3 processor, and the
Windows 8 Standard operating system

686280-501

Equipped with the Intel HM70 Express chipset, an Intel Pentium or Celeron processor, and the
Windows 8 Professional operating system

688018-601

Equipped with the Intel HM70 Express chipset, an Intel Pentium or Celeron processor, and the
Windows 8 Standard operating system

688018-501

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. WLAN module (see WLAN module on page 42)

c. Keyboard (see Keyboard on page 45)

d. Optical drive (see Optical drive on page 49)

e. Hard drive (see Hard drive on page 51)

f. Top cover (see Top cover on page 55)

When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 41)

● RTC battery (see RTC battery on page 54)

● Fan/heat sink assembly (see Fan/heat sink assembly on page 71)

● Processor (see Processor on page 73)
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Remove the system board:

1. Disconnect the following cables from the system board.

(1) Speaker cable

(2) Optical drive connector cable

(3) Display panel cable

(4) USB board cable

(5) Power connector cable

2. Remove the three Phillips PM2.5×6.0 screws (1) that secure the system board to
the base enclosure.

3. Lift the right side of the system board (2) until it rests at an angle.
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4. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.

Fan/heat sink assembly

Description Spare part number

Fan/heat assembly (includes replacement thermal material) 686259-001

Before removing the fan/heat sink assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)
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d. Top cover (see Top cover on page 55)

e. System board (see System board on page 69)

Remove the fan/heat sink assembly:

1. Turn the system board upside down, with the front toward you.

2. Disconnect the fan cable (1) from the system board.

3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (2) that secure the fan/heat sink assembly to the system board.

4. Remove the fan/heat sink assembly (3).

NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and processor, it may be necessary to move the processor heat sink from side to side to
detach it.

The thermal material must be thoroughly cleaned from the surfaces of the processor heat sink and
the processor each time the processor heat sink is removed. Replacement thermal material is included
with the processor heat sink and system board spare part kits.

NOTE: The following illustration shows the replacement thermal material locations. Thermal paste is
used on the processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the fan/heat sink assembly.

Processor

Description Spare part number

Intel Dual Core i5-3230M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

711903-001

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

680645-001

Intel Dual Core i3-3130M 2.60-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 713163-001

Intel Dual Core i3-3120M 2.50-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 700627-001

Intel Dual Core i3-2348M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 713165-001

Intel Dual Core i3-3110M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

Intel Dual Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001

Intel Dual Core i3-2350M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 653340-001

Intel Dual Core i3-2330M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 653339-001

Intel Dual Core i3-2328M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 693542-001

Intel Pentium 2030M 2.50-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual core, 35 W) 713164-001

Intel Pentium 2020M 2.40-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual core, 35 W) 700628-001

Intel Pentium B980 TJ85 2.40-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

692428-001

Intel Pentium B970 TJ85 2.30-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

676785-001

Intel Pentium B960 TJ85 2.20-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

664662-001

Intel Pentium B950 TJ85 2.10-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

653338-001
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Description Spare part number

Intel Celeron DC 1000M 1.80-GHz processor (1600-MHz FSB, 2.0-MB L3 cache, dual core,
35 W)

713162-001

Intel Celeron DC B830 1.80-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core, 35 W) 699547-001

Intel Celeron DC B820 1.70-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, dual core, 35 W) 690537-001

  

Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

e. System board (see System board on page 69)

Remove the the processor:

1. Turn the system board upside down, with the front toward you.

2. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.
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3. Remove the processor (3).

NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40).

5. Disconnect the wireless antenna cables from the WLAN module (see Memory module
on page 41).

6. Remove the following components:

a. Keyboard (see Keyboard on page 45)

b. Hard drive (see Hard drive on page 51)

c. Top cover (see Top cover on page 55)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.
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2. Release the wireless antenna cables (2) from the clips and routing channel built into the
base enclosure.

CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

3. Remove the five Phillips PM2.5×6.5 screws (1) that secure the display assembly to
the base enclosure.
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4. Remove the display assembly (2).

5. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the two display bezel screw covers (1) and the two Phillips PM2.5×5.5 screws (2)
that secure the display bezel to the display assembly.

b. Flex the inside edges of the bottom edge (3), the left and right sides (4), and the
top edge (5) of the display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (6). The display bezel is available using the following spare
part numbers:

● 686255-001 — For use on Compaq Presario CQ58 computer models

● 686254-001 — For use on HP 2000 Notebook PC computer models
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6. If it is necessary to replace the display hinge covers:

a. Remove the two Phillips PM2.5×4.0 screws (1) that secure the display hinge covers to the
display enclosure.

b. Remove the display hinge covers (2). The display hinge covers are available using spare
part number 686260-001.
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7. If it is necessary to replace the display panel:

a. Release the display panel cable (1) from the clips built into the bottom edge of the
display enclosure.

b. Remove the four Phillips PM2.5×4.0 screws (2) that secure the display panel to the
display enclosure.

c. Lift the top edge of the display panel (3), and then swing it up and forward until it rests
upside down in front of the display enclosure.

d. Release the adhesive support strip (1) that secures the display panel cable to the
display panel.

e. Detach the display panel cable (2) from the display panel. (The display panel cable is
attached to the display panel with double-sided tape.)
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f. Disconnect the display panel cable (3) from the display panel.

g. Remove the display panel. The display panel is available using spare part number
686273-001.

8. If it is necessary to replace the display hinges:

a. Remove the six Phillips PM2.0×3.5 screws (1) that secure the display hinges to
the display panel.
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b. Remove the display hinges (2). The display hinges are available using spare part number
686262-001.

9. If it is necessary to replace the display panel cable:

a. Detach the display panel cable (1) from the display enclosure. (The display panel cable is
attached to the display enclosure with double-sided tape in multiple locations.)

b. Disconnect the webcam/microphone cable (2) from the webcam/microphone module.
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c. Remove the display panel cable (3). The display panel cable is available using spare part
number 686256-001 and includes the webcam/microphone cable.
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10. If it is necessary to replace the webcam/microphone module, gently detach the webcam/
microphone module from the display enclosure. (The webcam/microphone module is attached to
the display enclosure with double-sided tape.)

CAUTION: Due to the thin profile of the webcam/microphone module, it is easily damaged.
Take extra precaution to ensure the webcam/microphone module is not damaged when removing
and replacing the module.

The webcam/microphone module is available using spare part numbers 703461-001 (HD
webcam/microphone module) and 686285-001 (non-HD webcam/microphone module).

NOTE: Depending on computer model, some computer models may be equipped one or two
sets of wireless antenna cables and transceivers.

11. If it is necessary to replace the wireless antenna cables and transceivers:

a. Detach the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the wireless antenna cables from the clips and routing channels along the left, right,
and bottom edges of the display enclosure (2).
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c. Remove the wireless antenna cables and transceivers (3). The wireless antenna cables and
transceivers are available using spare part number 686249-001.

Reverse this procedure to install the display assembly.

Power connector cable

Description Spare part number

Power connector cable (includes bracket) 686258-001

Before removing the power connector cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 40), and then remove the following components:

a. Memory module/wireless module compartment cover (see Memory module on page 41)

b. Keyboard (see Keyboard on page 45)

c. Hard drive (see Hard drive on page 51)

d. Top cover (see Top cover on page 55)

e. Display assembly (see Display assembly on page 76)

Remove the power connector cable:

1. Disconnect the power connector cable (1) from the system board.

2. Remove the Phillips PM2.5×6.5 screw (2) that secures the power connector and bracket to
the base enclosure.
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3. Remove the power connector bracket (3).

4. Remove the power connector cable (4).

Reverse this procedure to install the power connector cable.
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5 Using Setup Utility (BIOS) and
System Diagnostics

87



Windows 8
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
(BIOS) includes settings for the types of devices installed, the startup sequence of the computer, and the
amount of system and extended memory.

Starting Setup Utility (BIOS)

To start Setup Utility (BIOS), turn on or restart the computer, quickly press esc, and then press f10.

Information about how to navigate in Setup Utility (BIOS) is located at the bottom of the screen.

NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the
computer from operating properly.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility (BIOS).

1. Start Setup Utility (BIOS).

2. Use the arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the arrow keys to select Exit, select
Exit Discarding Changes, and then press enter.
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Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then select File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using System Diagnostics

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly.

To start System Diagnostics:

1. Turn on or restart the computer, quickly press esc, and then press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.
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SUSE Linux
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 37.60 cm 14.80 in

Depth 24.70 cm 9.72 in

Height (front to rear) 3.05 to 3.58 cm 1.20 to 1.41 in

Weight 2.45 kg 5.39 lb

Input power

Operating voltage and current 18.5V/ 3.5A or 19.5V/ 3.33A – 65W

19V/ 4.74A or 19.5V/ 4.62A – 90W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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15.6-in, SVA, display panel display specifications

 Metric U.S.

Dimensions

Height 19.6 cm 7.72 in

Width 34.7 cm 13.66 in

Diagonal 39.8 cm 15.67 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 250 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, +50° vertical (typical)
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Hard drive specifications

 750-GB* 640-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Length 100.4 mm 100.4 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g 110 g

Interface type SATA SATA SATA SATA

Transfer rate

Synchronous
(maximum)

1.1 GB/sec 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 1.5 ms 1.5 ms

Average (read/write) 11/13 ms 11/13 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms 22 ms

Logical blocks 1,465,159,751 1,250,269,655 976,773,168 628,142,448

Disk rotational
speed

5400 rpm 5400 rpm 5400 rpm 5400 rpm

Operating
temperature

0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery
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Windows 8
Your computer includes tools provided by HP and the operating system to help you safeguard your
information and retrieve it if you ever need to. These tools will help you return your computer to a
proper working state or even back to the original factory state, all with simple steps.

This chapter provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This guide describes an overview of backing up, restoring and recovering options. For more
details about the tools provided, see Help and Support. From the Start screen, type h, and then select
Help and Support.

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a backup
of the HP Recovery partition on the computer. The backup can be used to reinstall the original
operating system in cases where the hard drive is corrupted or has been replaced.

HP Recovery media you create will provide the following recovery options:

● System Recovery—Reinstalls the original operating system and the programs that were
installed at the factory.

● Minimized Image Recovery—Reinstalls the operating system and all hardware-related drivers
and software, but not other software applications.

● Factory Reset—Restores the computer to the state its original factory state by deleting all
information from the hard drive and re-creating the partitions. Then it reinstalls the operating
system and the software that was installed at the factory.

See Creating HP Recovery media on page 100.

2. As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Windows Help and Support. From the Start screen,
type h, and then select Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal
information. Windows File History can be set to regularly and automatically back up files from
libraries, Desktop, contacts, and favorites. If files are accidentally deleted from the hard drive and
they can no longer be restored from the Recycle Bin, or if files become corrupted, you can restore
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the files that you backed up using File History. Restoring files is also useful if you ever choose to
reset the computer by reinstalling Windows or choose to recover using HP Recovery Manager.

NOTE: File History is not enabled by default, so you must turn it on.

For more information and steps for enabling Windows File History, see Windows Help and
Support. From the Start screen, type h, and then select Help and Support.

Creating HP Recovery media

HP Recovery Manager is a software program that offers a way to create recovery media after you
successfully set up the computer. HP Recovery media can be used to perform system recovery if the
hard drive becomes corrupted. System recovery reinstalls the original operating system and the
software programs installed at the factory, and then configures the settings for the programs. HP
Recovery media can also be used to customize the system or aid in the replacement of a hard drive.

● Only one set of HP Recovery media can be created. Handle these recovery tools carefully, and
keep them in a safe place.

● HP Recovery Manager examines the computer and determines the required storage capacity for
the blank USB flash drive or the number of blank DVD discs that will be required.

● To create recovery discs, your computer must have an optical drive with DVD writer capability,
and you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, DVD+R DL discs. Do not use
rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or instead you can use a
high-quality blank USB flash drive.

● If your computer does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs, or you can obtain recovery discs for your computer from the
HP website. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide support,
go to http://welcome.hp.com/country/us/en/wwcontact_us.html. If you use an external optical
drive, it must be connected directly to a USB port on the computer; the drive cannot be connected
to a USB port on an external device, such as a USB hub.

● Be sure that the computer is connected to AC power before you begin creating the
recovery media.

● The creation process can take up to an hour or more. Do not interrupt the creation process.

● If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue, and the remaining discs will be burned.

To create HP Recovery media:

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Recovery Media Creation, and follow the on-screen instructions to continue.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 103.
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Restore and recovery

There are several options for recovering your system. Choose the method that best matches your
situation and level of expertise:

● If you need to restore your personal files and data, you can use Windows File History to restore
your information from the backups you created. For more information and steps for using File
History, see Windows Help and Support. From the Start screen, type h, and then select Help
and Support.

● If you need to correct a problem with a preinstalled application or driver, use the Drivers and
Applications Reinstall option of HP Recovery Manager to reinstall the individual application
or driver.

From the Start screen, type recovery, select HP Recovery Manager, and then select Drivers
and Applications Reinstall, and follow the on-screen instructions.

● If you want to restore the system to a previous state without losing any personal information,
Windows System Restore is an option. System Restore allows you to restore without the
requirements of Windows Refresh or a reinstallation. Windows creates system restore points
automatically during a Windows update and other system maintenance events. Even if you did not
manually create a restore point, you can choose to restore to a previous point, automatically
created. For more information and steps for using Windows System Restore, see Windows Help
and Support. From the Start screen, type h, and then select Help and Support.

● If you want a quick and easy way to recover the system without losing your personal information,
settings, or apps that came preinstalled on your computer or were purchased from the Windows
Store, consider using Windows Refresh. This option does not require backing up data to another
drive. See Using Windows Refresh for quick and easy recovery on page 102.

● If you want to reset your computer to its original state, Windows provides an easy way to remove
all personal data, apps, and settings, and reinstall Windows.

For more information, see Remove everything and reinstall Windows on page 103.

● If you want to reset your computer using a minimized image, you can choose the HP Minimized
Image Recovery option from the HP Recovery partition (select models only) or HP Recovery media.
Minimized Image Recovery installs only drivers and hardware-enabling applications. Other
applications included in the image continue to be available for installation through the Drivers and
Applications Reinstall option in HP Recovery Manager.

For more information, see Recovering using HP Recovery Manager on page 103.

● If you want to recover the computer's original factory partitioning and content, you can choose the
System Recovery option from the HP Recovery media. For more information, see Recovering using
HP Recovery Manager on page 103.

● If you have replaced the hard drive, you can use the Factory Reset option of HP Recovery media to
restore the factory image to the replacement drive. For more information, see Recovering using HP
Recovery Manager on page 103.

● If you wish to remove the recovery partition to reclaim hard drive space, HP Recovery Manager
offers the Remove Recovery Partition option.
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For more information, see Removing the HP Recovery partition on page 105.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.
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Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state. Using
the HP Recovery media you created, you can choose from one of the following recovery options:

● System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

● Minimized Image Recovery—Reinstalls the operating system and all hardware-related drivers and
software, but not other software applications.

● Factory Reset—Restores the computer to the state its original factory state by deleting all
information from the hard drive and re-creating the partitions. Then it reinstalls the operating
system and the software that was installed at the factory.

The HP Recovery partition (select models only) allows Minimized Image Recovery.
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What you need to know

● HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's
website or reinstall the software from the media provided by the manufacturer.

● Recovery through HP Recovery Manager should be used as a final attempt to correct
computer issues.

● HP Recovery media must be used if the computer hard drive fails.

● To use the Factory Reset or System Recovery options, you must use HP Recovery media.

● If the HP Recovery media do not work, you can obtain recovery media for your system from the HP
website. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide support, go
to http://welcome.hp.com/country/us/en/wwcontact_us.html.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data.
Before beginning recovery, back up any personal data you wish to retain.

Using the HP Recovery partition to recover a minimized image (select models only)

The HP Recovery partition (select models only) allows you to perform a minimized image recovery
without the need for recovery discs or a recovery USB flash drive. This type of recovery can only be
used if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select HP Recovery Manager, and follow the on-screen instructions.
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Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system
does not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the first HP Recovery disc you created into the optical drive on your computer or into an
optional external optical drive, and then restart the computer.

– or –

Insert the HP Recovery USB flash drive you created into a USB port on your computer, and then
restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the
computer boot order. See Changing the computer boot order on page 105.

3. Follow the on-screen instructions.

Changing the computer boot order

If computer does not restart in HP Recovery Manager, you can change the computer boot order, which
is the order of devices listed in BIOS where the computer looks for startup information. You can change
the selection for an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media you created.

2. Restart the computer.

3. Press and hold esc while the computer is restarting, and then press f9 for boot options.

4. Select the optical drive or USB flash drive you want to boot from.

5. Follow the on-screen instructions.

Removing the HP Recovery partition

HP Recovery Manager software allows you to remove the HP Recovery partition to free up
hard drive space.

IMPORTANT: Removing the HP Recovery partition means you can no longer use Windows Refresh,
the Windows Remove everything and reinstall Windows option, or the HP Recovery Manager option
for minimized image recovery. Create HP Recovery media before removing the Recovery partition to
ensure you have recovery options; see Creating HP Recovery media on page 100.

Follow these steps to remove the HP Recovery partition:

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and follow the on-screen instructions to continue.
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SUSE Linux
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
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4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVD±RW optical drive.

CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The recovery tool reinstalls the original operating system and HP programs and drivers that were
installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system
failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the
right pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-
Restore?

6. Follow the on-screen instructions.

SUSE Linux 107



USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the SLED
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore
the system to the original factory state when the F11 recovery option is not available. This process
should be done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or
on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The
Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered
has been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On
Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and select
No. The system will reboot. Back up the system data and repeat the previous steps. If no data
should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, applications, and settings from your computer, and reinstalls the Linux operating
system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves
user data.

● Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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